Contents

Copyrights ........................................................................................................ 5

1. Introduction........................................................................................................ 7
   1.1. This manual .................................................................................................. 7
   1.2. Use of symbols ............................................................................................ 7
   1.3. Product documentation ............................................................................. 8
   1.4. Document revisions .................................................................................... 8

2. Product overview .............................................................................................. 9

3. IEC 61850 standard ......................................................................................... 11

4. Installation .......................................................................................................... 13
   4.1. System requirements ................................................................................ 13
   4.2. REF 542plus SCL Tool installation ...................................................... 13
   4.3. Uninstalling REF 542plus SCL Tool ...................................................... 19

5. SCL files and folders ....................................................................................... 21
   5.1. 61850 XML File Pool ................................................................................ 21
   5.2. GUIData ..................................................................................................... 23
   5.3. Missing Dataset FCDA Entries ................................................................ 23
   5.4. UserData ................................................................................................... 23
   5.5. Symbol Library .......................................................................................... 23
   5.6. SCL schema file pool ................................................................................ 24
   5.7. XML templates .......................................................................................... 25

6. SCL Tool Components ..................................................................................... 27
   6.1. SCL GUI .................................................................................................... 27
       6.1.1. Menu bar ........................................................................................... 28
       6.1.2. SCL file generation ........................................................................... 31
       6.1.3. SCL Import ....................................................................................... 62
       6.1.4. FTP Download/Upload .................................................................. 90
   6.2. SCL core component ............................................................................... 94

7. SCL Tool error and exception handling ....................................................... 117
   7.1. Missing files ............................................................................................... 117
   7.2. Configuration Tool RCA file .................................................................. 118
   7.3. GUI Validations ....................................................................................... 118
       7.3.1. SCL Generation .............................................................................. 118
       7.3.2. SCL Import ..................................................................................... 124
       7.3.3. FTP download or upload ............................................................... 125

8. Terminology ..................................................................................................... 127

9. Abbreviations .................................................................................................. 129
Copyrights

The information in this document is subject to change without notice and should not be construed as a commitment by ABB Oy. ABB Oy assumes no responsibility for any errors that may appear in this document.

In no event shall ABB Oy be liable for direct, indirect, special, incidental or consequential damages of any nature or kind arising from the use of this document, nor shall ABB Oy be liable for incidental or consequential damages arising from use of any software or hardware described in this document.

This document and parts thereof must not be reproduced or copied without written permission from ABB Oy, and the contents thereof must not be imparted to a third party nor used for any unauthorized purpose.

The software or hardware described in this document is furnished under a license and may be used, copied, or disclosed only in accordance with the terms of such license.

Copyright © 2007 ABB Oy

All rights reserved.

Trademarks

ABB is a registered trademark of ABB Group. All other brand or product names mentioned in this document may be trademarks or registered trademarks of their respective holders.

Guarantee

Please inquire about the terms of guarantee from your nearest ABB representative.
1. Introduction

1.1. This manual

This manual provides thorough information on the REF 542plus SCL Tool application that is used to generate IEC 61850 standard compliant REF 542plus configuration files (SCL files). The REF 542plus Protect IT multifunction feeder protection and control unit, henceforth called REF 542plus, can be adapted to the IEC 61850-based substation communication standard to achieve interoperability between ABB products and the external IEC 61850 world.

In order to achieve this purpose, two major components are required:

- Communication component: Ethernet communication card
- IEC 61850 Configuration component: REF 542plus Engineering Tool for the Ethernet card

The purpose of this document is to describe the SCL Tool features and the user-related activity needed to interact with the SCL Tool in order to obtain the SCL files.

User interface, configuration aspects, generation of SCL files and loading of SCL files into the Ethernet Board are described in this document. This information is intended for application engineers who are familiar with the REF 542plus engineering methodology and the IEC 61850-6 standard-based terminology and engineering to some extent.

1.2. Use of symbols

This publication includes the following icons that point out safety-related conditions or other important information:

The information icon alerts the reader to relevant facts and conditions.

It should be understood that operation of damaged equipment could, under certain operational conditions, result in degraded process performance leading to information or property loss. Therefore, comply fully with all notices.
1.3. Product documentation

<table>
<thead>
<tr>
<th>Name of the Manual</th>
<th>Document ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Real Time Clock Synchronization, IRIG-B Input Time Master</td>
<td>1MRS755870</td>
</tr>
<tr>
<td>CAN Manual</td>
<td>1VTA100189-Rev 1, en</td>
</tr>
<tr>
<td>Configuration Manual</td>
<td>1MRS755871</td>
</tr>
<tr>
<td>iButton Programmer User Manual</td>
<td>1MRS755863</td>
</tr>
<tr>
<td>Manual Part 3, Installation and Commission</td>
<td>1VTA100004</td>
</tr>
<tr>
<td>Manual Part 4, Communication</td>
<td>1VTA100005</td>
</tr>
<tr>
<td>Motor Protection with ATEX Certification, Manual</td>
<td>1MRS755862</td>
</tr>
<tr>
<td>Operator's Manual</td>
<td>1MRS755869</td>
</tr>
<tr>
<td>Protection Manual</td>
<td>1MRS755860</td>
</tr>
<tr>
<td>Technical Reference Manual</td>
<td>1MRS755859</td>
</tr>
<tr>
<td>Technical Reference Modbus RTU</td>
<td>1MRS755868</td>
</tr>
<tr>
<td>Web Manual, Installation</td>
<td>1MRS755865</td>
</tr>
<tr>
<td>Web Manual, Operation</td>
<td>1MRS755864</td>
</tr>
</tbody>
</table>

1.4. Document revisions

<table>
<thead>
<tr>
<th>Version</th>
<th>IED Revision number</th>
<th>Date</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>2.5</td>
<td>31.05.2007</td>
<td>First release</td>
</tr>
</tbody>
</table>

Applicability

This manual is applicable to REF 542plus Release 2.5, software version V4E04x.
2. Product overview

The REF 542plus is connected to the substation bus, which is based on the IEC 61850 standard, along with other devices like MicroSCADA (Substation Monitoring/Control Human Machine Interface), PCM 600 (IED Configuration Manager), COM 600 (Substation Gateway) and other ABB and/or 3rd party protection and control devices through an Industrial grade Ethernet switch, see Fig. 2.-1. Any generic 3rd party IEC 61850 client can also be connected to the network to access the IEC 61850 configuration and real-time data from the REF 542plus.

![Connection diagram](image)

Fig. 2.-1 Connection diagram

The IEC 61850 standard requires that data from the REF 542plus is available in structured formats (data models/classes and so on). The prescribed way of achieving this objective is through files in XML-based format, termed as Substation Configuration description Language (SCL).

The REF 542plus SCL Tool generates an SCL file, containing generic and project specific data (from/to REF 542plus) and mapping information between REF 542plus ETHERNET BOARD and IEC 61850. The SCL Tool provides a graphical user interface (GUI) where the application engineer can choose the desired REF 542plus functions. The SCL Tool uses this information and automatically generates a project specific SCL file. The final form of this file is downloaded to the REF 542plus Ethernet board.
3. **IEC 61850 standard**

The IEC 61850 standard defines the communication between the IEDs in substations.

The IEDs support the following functions:

- Protection and control
- Integration of innovative sensor and switch technologies
- Metering, supervisory control and data acquisition (SCADA)
- Remote monitoring and fault diagnostics
- Automated dispatch and control
- Asset management
- Condition monitoring and diagnostics

IEC 61850 provides:

- Standardized information models for all kinds of protection relays, controllers, disconnectors, earthing switches, circuit breakers, transformers and so on.
- Information exchange methods to access the information model’s data: report sequences of events, log historical data, control devices, sampled value distribution, fast peer-to-peer process data exchange and so on.
- A unified system configuration language (XML-based) and device on-line self description.

Compared to other communication standards for Substation Automation, the IEC 61850 standard defines data modeling and communication services for this specific domain. Data modeling is mapped to a communication protocol, Manufacturing Message Specification (MMS, ISO 9506 protocol), which uses TCP/IP and Ethernet. In addition to the communication specifications, engineering information exchange is defined in SCL, which is an XML-based language.
4. Installation

4.1. System requirements

The system requirements for the SCL Tool are as follows:

- **Hardware requirements**
  - Pentium III, 800MHz or higher
  - 128MB RAM or higher
  - 13MB free hard disk space

- **Software requirements**
  - MSXML 4.0
  - Microsoft .NET Framework 2.0

The SCL Tool is compatible with the following versions:

- REF 542plus hardware Firmware version 2.5 SP1
- REF 542plus Configuration Tool version V4E04x

4.2. REF 542plus SCL Tool installation

Follow these steps to install the SCL Tool:

1. Close all applications.
2. Open the SCL Tool installation package which contains the two items shown in Fig. 4.2.-1.
3. Double-click on the Setup.exe file to start the SCL Tool installation.

   The REF 542plus SCL tool setup wizard dialog opens.
4. Click **Next**.

   The Installation folder selection dialog opens.
5. To exit the installation, click **Cancel** in any dialog during the installation.

6. In the cancel confirmation dialog, click **Yes** to exit the installation or
   
   Click **No** to continue the installation.

7. Select the folder in which the SCL Tool application is to be installed.
8. Click **Browse** to select a different folder.
9. Select the folder to install the application in and click **OK**.

10. Click the **Disk Cost** button to see the disk space that the SCL Tool requires.

11. Click **OK** to return to the previous dialog.

12. Click **Next** to go to the next dialog.
13. Click **Next** to confirm the installation.
14. Click **Close** to exit from the installation.

An icon is set up on the local machine desktop to launch the SCL Tool Application.

15. To start the SCL Tool application, double-click the REF 542plus SCL Tool icon or

In the Windows task bar, select **Start > Programs > REF 542plus SCL Tool**
4.3. **Uninstalling REF 542plus SCL Tool**

Follow the steps below to uninstall the REF 542plus SCL Tool

1. In the Windows task bar, select **Start > Settings > Control Panel > Add or Remove Programs**

   The Add or Remove Programs dialog opens.

2. Select the REF 542plus SCL Tool Ver2.1 file.

3. Click **Remove**.

4. Verify that the icon on the desktop and SCL Tool selection option in **Start > Programs** have been removed.

   The uninstallation only removes the SCL Tool. It does not remove the .NET Framework.
5. **SCL files and folders**

Some of the critical folders and files that get installed by the SCL Tool installation wizard are listed and described in the following.

5.1. **61850 XML File Pool**

The 61850 XML file pool, as the name suggests, is a collection of XML files in the SCL Tool program folder. The folder is the super set of all available functions in the REF 542plus with their respective SCL tree structures, logical devices (LD), logical nodes (LN), data objects (DO), data attributes (DA), data type templates for the LNs, DOs, DAs and so on. In short, the entire SCL structure (split into various files) required to configure a project specific IEC 61850 compliant REF 542plus IED configuration is present in this file pool.

The 61850 XML file pool consists of the files shown in the Fig. 5.1.1 and are as a whole listed below:

- **REF542plus. XML**
  
  This file consists of scaling functions to convert SPA data values to IEC 61850 standard values, and of the logical node zero of REF 542plus (LLN0) and logical node for REF 542plus physical device information (LPHD).

- **Substation and Communication. XML**

  This consists of the substation and communication parts with default data. The default data are updated from the user data when the SCL generator is invoked for execution.

- **Protection. XML**
This file consists of all LNs designated for protection functions with SPA (SPA-OPC server modeling) address mapping. All standard data is allocated to LNs as per the IEC 61850 standard. Additional information from protection functions are mapped to LN GGIOs.

- **Measurement. XML**

  This consists of all probable measurement DOIs in a REF 542plus device. These DOIs (filtered and based on the configuration information in the .rca file) are added to the Measurement LN MMXU with filtering attributes.

- **Primary Switch. XML**

  This consists of typical LNs for Primary Switch functions like Interlocking open/close (LN CILO), for control/no control (LN CSWI), for Disconnector / Earth Switch (LN XSWI), for Circuit Breaker (LN XCBR). These LNs / DOIs have default data that is updated from the user data when the SCL generator is invoked for execution.

- **General Status and Control. XML**

  This comprises all possible DOIs that can be associated with general I/O functions, allocated under a LN class GGIO (Generic process I/O). The LN/DOIs have default data that is updated from the user data when the SCL generator is invoked for execution.

- **Data Type Templates. XML**

  This comprises of all possible LNTypes, DOTypes, DATypes, and Enumeration definitions for the LNs defined in the above files, except for the General Status and Control and Measurement functions.

- **Data Set. XML**

  This comprises of data set definitions for measurement and protection functions besides the status of protection functions (LNs).

- **Report Control Block. XML**

  This comprises of report control block definitions for all data sets that can be configured. The report control block have default parameters that would be updated from the user data when the SCL generator is invoked for execution.

- **FBDescription. XML**

  This part is not required for the standalone version of the REF 542plus SCL Tool but is required for PCM ConnPack. FB (as configured in FUPLA) references along with their respective Function Group assignment, PCM tree structure names and the like for protection, measurement, monitoring and control functions along with necessary filtering attributes are defined in the file.

- **FunctionListDescriptions. XML**

  This part too is not required for the standalone version of the REF 542plus SCL Tool but is required for PCM ConnPack. For all the FBs defined in the FBDescription. XML file a unique FB reference number is allocated along with necessary filtering attributes. This FB number reference is also made in the
Protection.XML, Measurement.XML, Primary Switch.XML and General Status and Control.XML files.

5.2. GUIData

This folder comprises the Folderpath.xml and Language.xml files. The Folderpath.xml file is used to store the RCA file path information, while the Language.xml file is used to store the language setting used by the user.

5.3. Missing Dataset FCDA Entries

During the SCL Generation, if the FCDA entries in a dataset exceed the maximum limit, the excess FCDA entries are collected into an XML file. This XML file is saved in this folder.

5.4. UserData

This folder is used to save the temporary file which is created when the SCL File generation process starts (by clicking the Generate button). This file is automatically deleted on completion of the SCL File generation process. One such file is created for every REF 542plus configuration. This file contains both GUI and imported RCA file data.

5.5. Symbol Library

This folder contains the SymbolLibrary.xml file. The file contains information for mapping the symbols in the REF Configuration Tool to the COM600 Tool symbols.
5.6. **SCL schema file pool**

This comprises a set of IEC 61850 standard XSD (XML Schema Definition) files that is to be used by the REF 542plus SCL Tool Core Component (explained later) to validate every SCL file created by the REF 542plus SCL Tool.

- **SCL.XSD**: Comprises references to SCL_Substation.XSD, SCL_IED.XSD, SCL_Communication.XSD and SCL_DataTypeTemplates.XSD.
- **SCL_Substation.XSD**: Schema file for the Substation section of the SCL file.
- **SCL_Communication.XSD**: Schema file for the communication section of the SCL file.
- **SCL_IED.XSD**: Schema file for the IED section of the SCL file.
- **SCL_DataTypeTemplates.XSD**: Schema file for the data type templates section of the SCL file.
5.7. XML templates

This folder comprises the following XML templates (file structures) used by the SCL tool to generate the CID/ICD file.

- BaseTemplateforCID.xml: Used when generating the CID file.
- BaseTemplateforICD.xml: Used when generating the ICD file

![XML templates](image-url)
6. **SCL Tool Components**

The SCL Tool can be divided into two major components:

- SCL GUI
- SCL Core Component

6.1. **SCL GUI**

The GUI component of the SCL Tool contains:

- **Menu bar**: Composed of five menu items, namely **File, View, Tools, Window** and **Help**
- **SCL File Operations Tab strip**: Composed of three tabs, namely SCL Generation, SCL Import and FTP Download or Upload.

When double-clicking the application icon on the desktop, the application opens and a window is displayed as shown in Fig. 6.1.-1.

The user can select any one of the three tabs in the SCL File Operations Tab strip described in the following:

- **SCL Generation**: In this tab, the user can enter the required configuration information for the REF device and generate the SCL files. Thus this tab aids in the creation of an SCL file.
- **SCL Import**: In this tab, the user can import an existing CID/ICD file, modify LNs and then export the same to an SCL file. Thus this tab aids in modification of an SCL file.
- **FTP Upload or Download**: In this tab, the user can download (move a CID file from the system hard disk to the REF 542plus Ethernet board) or upload (move a CID file from the REF 542plus Ethernet board to the system hard disk) via FTP. Thus this tab aids in adding a new configuration file to the Ethernet board or changing the configuration file already present on the Ethernet board.

By default the SCL Generation tab is selected, see Fig. 6.1.-1.
6.1.1. **Menu bar**

The menu bar contains the following main menus:

- **File**

  The **File** menu has the following menu commands:

  - **Import Configuration File** - To import the REF 542plus Configuration Tool XML file for the SCL Generation tab
  - **Generate SCL** - To generate the SCL file for the SCL Generation tab
  - **Import SCL File** - To import the SCL file for the SCL Import tab
  - **Export SCL File to Hard Disk** - To export the SCL file for the SCL Import tab
  - **Exit** – To exit from the SCL Tool

  Depending on the tab selected, the menu commands are enabled or disabled.
Fig. 6.1.1.-1 File menu

- **View**

  The **View** menu has a **Project Explorer** menu command that can be used to activate the project explorer for SCL Import. The menu command is enabled if the selected tab is SCL Import. Otherwise it is disabled.

Fig. 6.1.1.-2 View menu

- **Tools**

  The **Tools** menu consists of two types of menu commands, the default and dynamic menu commands. The default menu commands are always displayed while the dynamic menu commands are displayed depending on the selected tree node in the Project Explorer of the SCL Import tab.

  The default menu commands include:
  
  - **SCL Generator** - Selects the SCL Generator tab
  - **SCL File Import** - Selects the SCL Import tab
  - **FTP Download** - Selects the FTP Download or Upload tab
  - **Language Handling** – Opens a dialog where the user can choose a language that is supported by the SCL Tool.

  Dynamically a menu command is added to the **Tools** menu depending on the node selected in the Project Explorer of the SCL Import tab.

  If the tree node selected is
  
  - **LD1**, the **LN Wizard** is displayed. Select the **LN Wizard** to open a dialog to add LNs.
  - **LN**, the **DO Wizard** is displayed. Select the **DO Wizard** to open a dialog to add DOIs.
- DOI, the **DOI Editor** is displayed. Select the **DOI Editor** to open a dialog to edit the attributes for the respective DOI.
- DS, the **Dataset Editor** is displayed. Select the **Dataset Editor** to open a dialog to add FCDAs to a dataset.

![Menu](image)

**Fig. 6.1.1-3 Tools menu**

- **Window**

  The **Window** menu displays all opened windows as menu commands for the SCL Import tab. For each instance of a wizard/editor, the respective menu command is displayed in the **Window** menu.
Help menu

The Help menu is provided to help the user to learn more about the SCL Tool. It consists of one menu command.

- **About SCL Tool** – Directs to the help documents for the SCL Tool.

## 6.1.2. SCL file generation

1. Double-click the application icon on the desktop.
2. Select the SCL Generation tab in the SCL File Operations tab strip.
The SCL Generation tab contains the 6 tabbed pages listed below, which have fields to configure for a REF 542plus device. Some of the fields (configuration information) are filled in by the user and the others are filled by the application after parsing the REF 542plus Configuration Tool XML file.

- Files and Folders
- Substation Relationship and Time Settings
- Measurement and Protection
- Primary Switches
- General Status and Control I/Os
- Report Control Blocks

3. Select the Files and Folders tab.
   The fields in the tab are displayed.
4. Click **Import**.

   The Open File dialog box is displayed.

5. Select the REF 542plus Configuration XML/RCA file to import.
Once the file is selected, this REF 542plus Configuration XML/RCA file is parsed for the communication, measurement, protection functions and the switching objects-related information.

If any of the above data is not configured in the “rca” file, a dialog box pops up. For example if the protection functions are not configured, the dialog box shown in Fig. 6.1.2.-4 is displayed.
Once the file is imported, the entire directory text of the REF 542plus configuration RCA file appears in the text box and the file name appears in the Device Reference field.

6. To use previously saved GUI data, click **Import GUI Data**.

When this file is imported, the editable fields in all the tabs get filled with data present in the GUD file.

7. To select a GUD file, see Fig. 6.1.2.-6 and click **Open**.

8. Click **Browse** to select the SCL folder.
The generated SCL file is saved to this folder.

9. Click **Make New Folder** to create a new project folder or choose an existing folder.

![Browse For Folder dialog](image)

**Fig. 6.1.2.-7 Browse For Folder dialog**

10. When the project folder is chosen, the entire directory text appears in the text box, see Fig. 6.1.2.-8.

![SCL file folder path](image)

**Fig. 6.1.2.-8 SCL file folder path**

11. Select type of SCL file to be generated, see Fig. 6.1.2.-9.

![Selecting SCL file type](image)

**Fig. 6.1.2.-9 Selecting SCL file type**

12. Select ***.ICD** to generate an ICD file and ***.CID** to generate a CID file.

The SCL tool can be used to create only one type of file(s) in a cycle. When selecting the ICD option the Substation Relationship and Time Settings tab gets hidden, see Fig. 6.1.2.-10.
It is only possible to navigate to other tabs in the SCL Generation tab if all fields in the Files and Folders tab have been filled.

13. Select the *.CID option in SCL file type options list. The Substation Relationship and Time Settings tab is displayed again, see figure below.
14. Click **Import SVG** to open the Open File dialog in which the user can select the SVG file containing SLD information for import.
Once the file is selected, the entire file is parsed for SLD-related information. 

15. Select the Substation Relationship and Time Settings tab to define the REF 542plus device’s relationship to the Substation.
Enter the definitions for the following fields:

- **Substation Name**: If the check box for the IED Name is not checked, define a substation name not longer than 15 characters. If the IED Name check box is checked to automate the IED Name generation, enter the substation name up to 3 characters, see Fig. 6.1.2.-14.
**SCL Tool**

*Configuration manual*

<table>
<thead>
<tr>
<th>Substation Relationship</th>
<th>Substation Name</th>
<th>Voltage Level Designation</th>
<th>Voltage Level Index</th>
<th>Voltage Level Value(kV)</th>
<th>Bay Designation</th>
<th>IED Designation</th>
<th>IED Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>SUB</td>
<td>SUBSTATION</td>
<td>H</td>
<td>F</td>
<td>H</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Fig. 6.1.2.-15**  **Entering a substation name for the automated IED name**

- **Voltage Level Designation**: Select the voltage level designation from a drop-down list.

**Fig. 6.1.2.-16**  **Selecting the voltage level designation**

- **Voltage Level Index**: Select the voltage level index from a drop-down list.

**Fig. 6.1.2.-17**  **Selecting the voltage level index**
- Voltage Level Value: Depending on the voltage level selected, enter the voltage value.

A tool tip appears to show the voltage value range applicable for the selected voltage level.

Fig. 6.1.2.-18  Entering the voltage value

- If the check box for IED Name is not checked, enter the Bay Designation up to 10 characters. If the IED Name check box is checked to automate the IED Name generation, enter the Bay Designation up to 3 characters, see Fig. 6.1.2.-19.

Fig. 6.1.2.-19  Entering the bay designation
Enter the IED Designation up to 2 characters. If the IED Name check box is selected to automate the IED name generation, the IED Designation field is enabled. If the IED Name check box is not selected, the IED Designation field is disabled.

- If the IED Name check box is unchecked, IED Name field is enabled. Enter the IED Name up to 10 characters.

- If the IED Name check box is unchecked, IED Name field is enabled. Enter the IED Name up to 10 characters.
If the IED Name check box is checked, IED Name fills in automatically the Substation Name, Voltage Level Designation, Voltage Level Index, Bay Designation, and IED Designation values. The Substation Name and Bay Designation values are replaced with the first 3 characters if their lengths are greater than 3.

Enter the IP addresses for the SNTP servers 1, 2, 3 and 4. This is used by the REF 542plus ETHERNET BOARD as communication parameters for communication with IEC61850 clients.
Select the DST Correction from the drop-down list. It ranges from 0.00 hour to 2.00 hour.

If the user selects a value other than 0.00, then the Start of DST and End of DST group boxes are enabled.

Select Week Day, Month, After Month Day, Hour, Minute and Second for both Start of DST and End of DST.
Enter the Time zone correction factor, which varies from +13 hours to -12 hours Coordinated Universal Time.

16. Select the Measurement and Protection tab to view the channel information and the protection functions configured in the imported REF 542plus configuration RCA file.
17. Select the Primary Switches tab.

It displays all the configured switching devices and respective FUPLA object types in a table.
The IEC 61850 enabled, the designation and controllable columns are editable. In case of ICD file generation the Designation column is hidden.

The default values for the columns IEC 61850 enabled and Controllable are Yes. The user can select the IEC 61850 enable column as a Yes/No only for Switching object 2-2. A Yes results in enabling further fields for user entry whereas a No results in the rest of the fields turning grey (non-editable). On No, the entry is not configured in the SCL file.
### 18. Enter the designation up to 10 characters.

<table>
<thead>
<tr>
<th>Type of Switching device</th>
<th>IEC 61869 Enabled?</th>
<th>Designation</th>
<th>FUPLA object type</th>
<th>SPA Channel</th>
<th>Controllable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Earthing Switch</td>
<td>Yes</td>
<td>Sw</td>
<td>Switching object 2-2</td>
<td>21</td>
<td>Yes</td>
</tr>
<tr>
<td>Disconnector</td>
<td>No</td>
<td></td>
<td>Switching object 2-2</td>
<td>11</td>
<td>Yes</td>
</tr>
<tr>
<td>Disconnector</td>
<td>Yes</td>
<td></td>
<td>Switching object 2-2</td>
<td>9</td>
<td>Yes</td>
</tr>
<tr>
<td>Disconnector</td>
<td>Yes</td>
<td></td>
<td>Switching object 2-2</td>
<td>7</td>
<td>Yes</td>
</tr>
<tr>
<td>Circuit Breaker</td>
<td>Yes</td>
<td></td>
<td>Switching object 2-2</td>
<td>10</td>
<td>Yes</td>
</tr>
<tr>
<td>Earthing Switch</td>
<td>Yes</td>
<td></td>
<td>Switching object 4-4</td>
<td>8</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Fig. 6.1.2.-30 Primary Switches table**

### 19. In the controllable column, select either Yes or No to confirm whether the switch is controllable or not.

<table>
<thead>
<tr>
<th>Type of Switching device</th>
<th>IEC 61869 Enabled?</th>
<th>Designation</th>
<th>FUPLA object type</th>
<th>SPA Channel</th>
<th>Controllable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Circuit Breaker</td>
<td>Yes</td>
<td>CB</td>
<td>Switching object 2-2</td>
<td>10</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Fig. 6.1.2.-31 Entering the designation**

20. Select the General Status and Control I/Os tab. It displays the FUPLA object reference, Spa channel/Data number parsed from REF 542plus configuration tool XML file in a table.
21. In the IEC 61850 enabled column, select **Yes** or **No**.

A **Yes** results in enabling further fields for user entry, whereas a **No** results in the rest of the fields turning grey (non-editable). On **No**, the entry is not configured in the SCL file.
22. Enter the signal designation up to 20 characters.

23. Enter the LN GGI0 Prefix up to 4 characters.
24. Enter the LN Ggio instance number between 1 to 255.

25. Select the DOI name from the drop-down list which is filled on basis of the FUPLA object reference. The following options are available for the possible FUPLA object references:

- For a Binary Read/Switching Object 0-1 FUPLA object, an Alm (Alarm), an Ind (Indication) and an SPSCO (Single Point Controllable Status Output) DOI option are provided for selection.

- For a 16 bit Read FUPLA object, an IntIn (Integer Status) and an ISCSO (Integer Status Controllable Status Output) DOI option are provided for selection.

- For a 16 bit Write FUPLA object, only an ISCSO (Integer Status Controllable Status Output) DOI option is provided for selection.

- For a Binary Write or a Switching object 1-0 or a Direct Read Write or a Switching object 1-1 FUPLA object, only an SPCSO (Single Point Controllable Status Output) DOI option is provided for selection.

26. Enter the DOI number up to 2 digits.
27. For the DS allocation, select either Yes or No.

A Yes entry confirms the corresponding DOI entry (along with LN class, LN instance number and LD) into the DS. A No entry results in the non-inclusion of a DOI entry into the DS.

28. Select the Report Control Blocks tab.

This displays the default Report control blocks by parsing the Report Control Block.xml from the 61850 file pool. By default, clients are four and the fifth client can be inserted in the SCL Import section.
The user can edit all the columns against each dataset. In case of an ICD file generation, the second table is hidden.
Fig. 6.1.2-42 Report Control Blocks tab with ICD file generation

29. Select the **Buffer Enable** from the drop-down list for the dataset.

Fig. 6.1.2-43 Buffer Enable column

30. Enter the Buffer Time up to 3 digits.
31. Select the maximum number of subscribing clients from the drop-down list.

32. Enter the Configuration Revision up to 2 digits.

33. Select the Sequence Enable from the drop-down list.
34. Select the Timestamp Enable from the drop-down list.

35. Select the Reason code Enable from the drop-down list.
36. Select the maximum DataRef Enable from the drop-down list, see Fig. 6.1.2.-51.

37. Select the EntryID Enable from the drop-down list.

38. Select the ConfigRef Enable from the drop-down list.
To define the IP, IP Subnet and IP Gateway for the four clients under the communication section, the second table is provided with default values.

39. Enter the Client IED name up to 7 characters in the second table.

40. Enter the IP address other than 0.0.0.0 and 255.255.255.255.

41. Enter the IP Subnet address other than 0.0.0.0 and 255.255.255.255.
42. Enter the IP Gateway address other than 0.0.0.0 and 255.255.255.255.

43. Click **Generate**.

A dialog box is displayed to ask whether to save the data that was entered in GUI.

44. To save the GUI data, click **Yes**.

A new dialog box opens.

45. Select a folder for the GUI data and enter the file name.

By default, the path for GUD is set as that of the RCA file path.
46. Enter the file name up to 15 characters.

47. Click **OK** to save the data entered in GUI to the Test.gud file. This starts the SCL generation process and after a successful creation of the SCL file(s), a dialog box shown in Fig. 6.1.2.-62 is displayed.

After the file generation the **Generate SCL** button is disabled, see Fig. 6.1.2.-63. This is because a cycle of the SCL generation is over once the file has been generated.
48. To generate another file, perform all the steps again starting from step 2.

6.1.3. **SCL Import**

1. Select the SCL Import tab.

   This tab opens the SCL file import section of the application, see Fig. 6.1.3.-1.
The Project Explorer on the left side displays the header node REF 542plus.

2. Right-click on this node to import an SCL file.
3. Select **Import SCL File** to open a dialog to choose a file and then import.
4. Click **Select SCL File** to browse for the file.
5. Select the file and click **Open** to import the file.

After the file is imported, the tree structure in the Project Explorer is updated. An IED node is added as a child node to the REF 542plus header node. The IED node has LD0 and LD1 as child nodes.
6. Right-click on LD0 and select **Expand** to expand.

7. Right-click on LD1 to expand.
8. Expand any of the LNs to view its DOIs.
9. Right-click on any of the DOIs to view the available options to edit a DOI.

---

**Fig. 6.1.3.-10** Overview of Project Explorer
10. Select **Properties** to open the property window for the DOI.
11. To view/edit the attributes of a DOI, right-click and select **DOIEditor** from the menu.

   The DOI editor opens, see Fig. 6.1.3.-14.
Fig. 6.1.3.-13  Selecting DOIEditor
12. To delete the DOI from the LN, right-click and select Delete.

This delete option is available only for DOIs under LNs of the GGiO type.
Fig. 6.1.3.-15 ObjectDelete dialog

13. Click **Yes** to delete the DOI from the LN.
14. To add a DOI to the LN, right-click on any LN of G Gio type and select **DOWizard**.

15. Select the DOI name from the selection list and enter the DOI number.
The possible DOI names with the DOTypes and CDCs are given in the following table.

<table>
<thead>
<tr>
<th>Serial No</th>
<th>DOI Name</th>
<th>DO Type</th>
<th>CommonData-Class</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Aim</td>
<td>SPS</td>
<td>SPS</td>
</tr>
<tr>
<td>2</td>
<td>AnIn</td>
<td>MV_simple</td>
<td>MV</td>
</tr>
<tr>
<td>3</td>
<td>Ind</td>
<td>SPS</td>
<td>SPS</td>
</tr>
<tr>
<td>4</td>
<td>IntIn</td>
<td>INS_int</td>
<td>INS</td>
</tr>
<tr>
<td>5</td>
<td>ISCSO</td>
<td>INC_control_int</td>
<td>INC</td>
</tr>
<tr>
<td>6</td>
<td>SPCSO</td>
<td>SPC_control</td>
<td>SPC</td>
</tr>
</tbody>
</table>

16. Enter the DOI number and click Add DOI to add the DOI to the LN.

The newly added DOI is highlighted in the Project Explorer field.
17. Right-click on LD1 and select **LN Wizard** to add an LN of GGO type to LD1.

![Fig. 6.1.3.-20 Selecting LN Wizard](image)

18. Enter the prefix and LN instant number.

![Fig. 6.1.3.-21 LN Wizard displayed in the SCL Tool window](image)
19. Click **Add LN** to add the LN to LD1.

20. To view the datasets and report controls blocks, expand LLN0 under LD0 in Project Explorer.
21. Right-click on any LLN0 and select **Add Dataset** to add a dataset and its corresponding RCB node.

The maximum number of datasets allowed is 6.

---

**Fig. 6.1.3.-24 Viewing the datasets**

**Fig. 6.1.3.-25 Adding a dataset**
22. Click on **StatUrgB** to add the dataset.

The dataset StatUrgB is added along with its corresponding RCB rcb_AB at the end.

![Fig. 6.1.3.-26 StatUrgB added to the Project Explorer](image)

23. To delete the dataset and its corresponding RCB, right-click the dataset and select **Delete**.
Fig. 6.1.3.-27  Deleting a dataset
24. Right-click on any dataset and select **DataSet Editor**, see Fig. 6.1.3.-29.

The DataSet Editor table opens and displays all the FCDAs in the dataset.
Fig. 6.1.3.-29  Selecting DataSet Editor
25. Expand any LN.

26. Drag and drop any DOI in it to the DataSet Editor.

The FCDAs corresponding to the DOI are added at the end of the DataSet Editor table.
Fig. 6.1.3.-31  FCDAs added at the end of the DataSet Editor

27. Expand an RCB.
28. Expand the ReportEnabled node under the RCB.
29. Right-click to add a Report Client, see Fig. 6.1.3.-32.
Fig. 6.1.3.-32 Adding a report client

If the newly added Report Client is the fifth client, a dialog box is displayed with IP details of Client 5.

![Fig. 6.1.3.-32 Adding a report client](image)

30. Click OK to save the IP addresses entered for the Client 5 node. The Client is then added as shown in Fig. 6.1.3.-34.
Set the properties for the added Client using the property bag. The IED Name property consists of the IED names.
31. To open a dialog to export the modified SCL file to the hard disk, right-click on the root node REF 542plus and select **Export SCL File to Hard Disk**.
32. Click **Write** to browse for the file name or type the file name to save the SCL file.

   A dialog is displayed once the file is exported successfully.
6.1.4. FTP Download/Upload

1. Select the FTP Download/Upload tab.

   The Download option button is selected by default.

2. By default, the SCL folder is the same as the folder where the REF 542plus SCL Tool generated CID files are stored. Click **Browse** to select any other SCL Folder containing the SCL Files.
3. Select the required CID file.

The IP addresses 1 and 2 appear automatically in the IP address drop-down box.
4. Select an IP address (primary or secondary IP address).

5. Enter the user name (abb for REF 542plus Ethernet Board).

6. Enter the user password (abb for REF 542plus Ethernet Board).

7. Click **Download** to initiate the FTP connectivity and start the CID file transfer from the hard disk to the REF 542plus Ethernet Board.

   A notification message appears after a successful file transfer to indicate that the SCL Tool is resetting the REF 542plus Ethernet Board to recognize the newly loaded file.

   The SCL Tool renames the CID file to .cid before downloading it to the REF 542plus Ethernet Board.
8. Select the Upload option button.
9. Click **Browse** to select the destination folder for the uploaded file in the hard disk.
10. Enter the IP address of the REF 542plus Ethernet Board.
11. Enter the user name (abb for REF 542plus Ethernet Board).
12. Enter the user password (abb for REF 542plus Ethernet Board).

A notification message appears after a successful file transfer into the selected destination folder.

13. Click **OK**.

The REF542plus.cid file is present in the destination folder.
6.2. **SCL core component**

The SCL Tool core component interacts with the two XML file pools which are generated to construct the REF 542plus SCL file(s) as per user configuration. The file pools are the User data XML file pool with the REF542plusconfiguration.xml file, and the 61850 XML file pool.

A brief explanation is given for the user to understand where exactly the user information is used in the SCL files. The user entries in the SCL Tool GUI are compared with the final form of the SCL files.

- After the SCL Generation, the SCL file’s header section shows the following:
  - the id attribute shows the names of the imported rca, gud and svg files.
    The gud file and svg files are added to the id attribute if they have been imported.
  - the version attribute shows the current date and time, and
  - the toolID attribute shows the current version of the SCL Tool.

[Fig. 6.2.-1 SCL file’s header section for SCL Generate](A070322)

- After the SCL Export, the id attribute in the in SCL file’s header section shows the names of the imported rca, gud, and svg files followed by the SCL Import.

[Fig. 6.2.-2 Header section for SCL Export](A070561)

- Substation section (applicable to CID files only):
  The Substation Relationship and Time Settings tab along with the relevant parts of the SCL file are shown in Fig. 6.2.-3.
As shown in Fig. 6.2.-3, the following entries are updated:

- Substation name
- Voltage Level Index
- Voltage Level Designation
- Voltage in kV
- Bay designation
- IED Designation
- IED Name

Communication section (applicable to CID files only):

The SNTP IP addresses section along with the relevant parts of the SCL file, are shown in Fig. 6.2.-4.
As shown in Fig. 6.2.-4, the following entries are updated for the Uplink communication in the SCL file:

- SNTP Server -1 IP address
- SNTP Server -2 IP address
- SNTP Server -3 IP address
- SNTP Server -4 IP address

Time settings section

The time settings section along with the relevant parts of the SCL file are shown in Fig. 6.2.-5.
As shown in Fig. 6.2.-5, the following entries are updated for the ‘Uplink’ communication in the SCL file:

- DST Correction
- StartDSTWeekDay
- StartDSTMonthDay
- StartDSTMonth
- StartDSTHour
- StartDSTMinute
- EndDSTWeekDay
- EndDSTMonthDay
• EndDSTMonth
• EndDSTHour
• EndDSTMinute
• EndDSTSecond

• Time zone correction section

The time zone correction update section along with the relevant parts of the SCL file are shown in Fig. 6.2.-6.

![Diagram of time zone correction](image)

**Fig. 6.2.-6** Time zone correction update section

• Measurement section

The measurement read-only data in GUI along with the relevant parts of the SCL file are shown in Fig. 6.2.-7.
As shown in Fig. 6.2.-7, the Net number 1 in the GUI results in one instance in LN MMXU.

As shown above, the read-only measurement information in GUI is updated for the MMXU LN SCL file:

- U under channels 456 and 8 results in DOI entries for Phase to Phase voltages and Phase to ground voltages.
- The user entry I under channels 123 and 7 results in DOI entries for Phase currents.
- The user entries U under channels 456 and I under channels 123, result in DOI entries for Real Power, Reactive Power, Apparent Power, Average Power Factor and Frequency.

- Primary Switch section

An entry for a circuit breaker CB with a FUPLA object Switching object 2-2, with control option Yes and SPA channel number 10, results in the following if the IEC61850 enable option is Yes:

The primary switch tab along with the relevant parts of the SCL file are shown in Fig. 6.2.-8.
The explanation for the primary switches part is as below:

- 1 LN CILO with prefix CB, instance number 10 and description Switching object 2-2 CircuitBreaker CB. Fields updated with 10 apart from the LN instance are SPA channel number fields in sAddr attributes of a DAI. SPA on event and off event codes are directly parsed from the RE542plusConfiguration.xml file and updated in LN CILO.

```
<LN [prefix="CB"] [InClass="CILLO"] [lnClass="CILLO"] [lnType="ABBREF542plus_CILLO"] [doc="Switching object 2-2 Circuit Breaker CB"]
  <DOI [name="Mod"]
    <DAI [name="KVAf"] [val="10"] [valKind="Saf"]
    <DAI [name="CIMode"] [val="0"] [valKind="Saf"]
    <DAI [name="Off"] [val="0"] [valKind="Saf"]
    <DOI [name="Och"]
    <DOI [name="Health"]
    <DOI [name="NonPlan"]
    <DOI [name="EnaQn"]
      <DAI [name="KVAf"] [val="0"] [valKind="Saf"]
      <DAI [name="Off"] [val="0"] [valKind="Saf"]
      <DOI [name="EnaCle"]
      <DAI [name="KVAf"] [val="0"] [valKind="Saf"]
```

**Fig. 6.2.-9 Channel number for CILO**

- 1 LN CSWI with prefix CB, instance number 10 and description Switching object 2-2 CircuitBreaker CB. Fields updated with 10 apart from the LN instance are SPA channel number fields in sAddr attributes of a DAI. sAddr for Pos contains both the control and status part.
Fig. 6.2.-10  Channel number for CSWI

- 1 LN XCBR with prefix CB, instance number 10 and description Switching object 2-2 CircuitBreaker CB. Besides the SPA channel numbers updated with 10 as in earlier LNs, the operational capability SPA data number is updated in the CB operational capability DOI/DAI/sAddr.
Fig. 6.2.-11 Channel number for XCBR

An entry for a circuit breaker CB with FUPLA object Switching object 2-2, with control option No and SPA channel number 10 results in the following if the IEC61850 enable option is Yes:

The primary switches tab along with the relevant parts of the SCL file are shown in Fig. 6.2.-12.

Fig. 6.2.-12 LN creation for non-controllable primary switches
The explanation for the primary switches part is as below:

- 1 LN CSWI with prefix CB, instance number 10 and description Switching object 2-2 CircuitBreaker CB. Fields updated with 10 apart from the LN instance are SPA channel number fields in sAddr attributes of a DAI. sAddr for Pos contains only status part.

![Fig. 6.2.-13 Channel number for CSWI](image)

- 1 LN XCBR with prefix CB, instance number 10 and description Switching object 2-2 CircuitBreaker CB. Besides the SPA channel numbers updated with 10 as in earlier LNs, the operational capability SPA data number is updated in the CB operational capability DOI/DAI/sAddr.
Protection section

The protection section along with the relevant parts of the SCL file are shown in Fig. 6.2.-15.
Fig. 6.2.-15 LN creation for the protection functions

Fig. 6.2.-16 LN creation for the protection functions
As shown above, the following data is updated:

- Depending on the SPA channel parsed from the REF542plusConfiguration.xml file, the corresponding protection LNs are included. For example, the Overcurrent directional, low set function has the SPA channel number 55 and hence two LNs of the PIOC class and GGIO class with the instance numbers 55 are included.

- General status and control section

The general status and control sheet along with the relevant parts of the SCL file are shown in the figure below.

![Data set part](image)

**Fig. 6.2.17 LN creation for GGIO**

As shown above, the following data is updated:

- LN prefix, instance number data from the GUI into the LN GGIO
- The FUPLA object name is updated in the DAI description field
- The SPA data number in the sAddr attribute of the DOI/DAI
- The signal designation in the DAI Val attribute
The combined DOI name and number as the DOI name attribute
The Data set enabled results in the addition of the DOI in the dataset
Combined DOIs in the general status and control section

The DOIs configured for LNs in the general status and control section are combined in case of SPCSO and ISCSO DO types. Two FUPLA object references are combined to form a DOI in the LN. The two FUPLA objects with the following combinations must have the same LN prefix, LN instance number, and DOI number for forming a combined DOI:

<table>
<thead>
<tr>
<th>DO Type</th>
<th>First FUPLA Object Reference</th>
<th>Second FUPLA Object Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPCSO</td>
<td>binary read</td>
<td>binary write</td>
</tr>
<tr>
<td>SPCSO</td>
<td>binary write</td>
<td>binary read</td>
</tr>
<tr>
<td>SPCSO</td>
<td>binary write</td>
<td>switching object 0-1</td>
</tr>
<tr>
<td>SPCSO</td>
<td>binary read</td>
<td>switching object 1-0</td>
</tr>
<tr>
<td>SPCSO</td>
<td>switching object 0-1</td>
<td>switching object 1-0</td>
</tr>
<tr>
<td>SPCSO</td>
<td>switching object 1-0</td>
<td>switching object 0-1</td>
</tr>
<tr>
<td>ISCSO</td>
<td>16 bit read</td>
<td>16 bit write</td>
</tr>
<tr>
<td>ISCSO</td>
<td>16 bit write</td>
<td>16 bit read</td>
</tr>
</tbody>
</table>

An example of a combined object is shown in Fig. 6.2.-18:

![Fig. 6.2.-18 DOI creation for GGOI LN](image)
Here SPCSO binary write – binary read FUPLA object references are combined to form one DOI under the LN.

- Report control blocks section

The report control blocks along with the relevant parts of the SCL file are shown in Fig. 6.2.-19, Fig. 6.2.-20 and Fig. 6.2.-21.
As shown above, the following data is updated under each report control block:

- Buffer enable
- Buffer time
- Maximum number of subscribing clients
- Configuration revision
- Sequence enable
- Time stamp enable
- Dataset enable
- Reason code enable
- DataRef enable
- Entry ID enable
- ConfigRef enable

The data in the second table is used to update the report control blocks tab as shown in Fig. 6.2.-22.
As shown above, the following information is updated under each client:

- IED name
- IP address
- IP-subnet
- IP-gateway
- Import section

When adding the fifth client under an RCB client list, a client node is created. The IP addresses entered are updated in the node as shown in Fig. 6.2.-23.
Fig. 6.2.-23  RCB client IP addresses updated

- Additional miscellaneous information in the SCL file

The device reference as entered in the GUI in the Files and Folders tab is updated in the REF 542plus LDevice node of the SCL file as the value of its description attribute, see Fig. 6.2.-24.
The revision information of the SCL Tool, and the date and time of generation of the SCL file are updated as the value content of the configRev element under the REF 542plus LLN0 node, see Fig. 6.2.-25.
Fig. 6.2.-25 SCL Tool version information

- SLD Information Addition

The SLD information derived by parsing the SVG file is added to the Bay Node in the SCL (ICD/ CID) file. The SVG file data along with the SLD information in SCL file is shown below:

- Symbol Information: Symbol type, subtype and direction are derived from the nameId field in the SVG file and placed in the SCL file as shown below. The nameId is used to get the above information from the SymbolsLibrary.xml file. Coordinates are derived from the transform attribute. These coordinates are scaled by 3 and snapped to the grid for better viewing in the COM600 SLD Editor. The Terminal information is derived from the intersection points between the Symbols and Lines.
Text Information: Text to be displayed and the coordinates are derived for an Annotation as shown in Fig. 6.2.-27. Here, too, the coordinates are scaled and then snapped to grid for better viewing in the COM600 SLD Editor.

ConnectivityNode Information: ConnectivityNode’s coordinates are determined from the Intersection points and then added to the SCL File as shown in Fig. 6.2.-28.

Fig. 6.2.-27 Annotation information in SCL file.

Fig. 6.2.-28 ConnectivityNode information in SCL file

Fig. 6.2.-29 SLD as viewed in the REF Configuration Tool and COM600 SLD

Fig. 6.2.-29 displays an SLD addition example where the SVG file information is parsed and added to the SCL file by the REF 542plus SCL Tool. In the property grid of COM600, the information corresponding to a symbol can be viewed.
The SCL Tool does not add any busbar information.

Another example of SLD addition is shown Fig. 6.2.-30.
7. SCL Tool error and exception handling

7.1. Missing files

The SCL Tool checks for the files that are required for the SCL generation in their respective folders. If the file is not found an appropriate message is displayed. The following folders are checked by the SCL Tool:

- 61850 file pool

If a 61850 file pool file is missing, then an exception message is shown by the SCL Tool. Fig. 7.1.-1 shows the error message displayed when the SCL Tool detects that the folder is missing the Protection.xml file.

- SCL schema file pool

If a SCL schema file pool file is missing, then an exception message is shown by the SCL Tool. Fig. 7.1.-2 shows the error message displayed when the SCL Tool detects that the folder is missing the CommonSA.xsd file.
7.2. Configuration Tool RCA file

The following messages are displayed when the .rca file is not configured properly:

- The SCL Tool detects if the communication board is configured as ETHERNET in the configuration tool RCA file. If it is not configured, the following message is displayed (see Fig. 7.2.-1).

![Communication board is not configured properly error message](image1.png)

- The SCL Tool detects if the imported configuration file is well formed. If the file is not adhering to the standards, the tool displays a message with the error type as shown in Fig. 7.2.-2.

![RCA file format error message](image2.png)

7.3. GUI Validations

7.3.1. SCL Generation

- An error message is displayed if one of the fields in the Files and Folders tab is not filled. For example, if the user selects another tab in the SCL Generation section without filling the SCL file type, then an error message is displayed as shown in Fig. 7.3.1.-1.

![Select SCL file type error message](image3.png)
- An error message is displayed when the user imports improper SVG file for loading SLD information. For example if the user imports an SVG file without named Information for a symbol then an error message will be displayed as shown in Fig. 7.3.1.-2.

Fig. 7.3.1.-2 Invalid SVG file import error message

- If correct voltage level value (greater than 420kV) is not filled for a voltage level designation (for example Level B) in the Substation and Communication tab, then an error message is displayed as shown in Fig. 7.3.1.-3.

Fig. 7.3.1.-3 Voltage level value error message

- If an incorrect SNTP IP address is filled in the Substation and Communication tab, an error message is displayed as shown in Fig. 7.3.1.-4.

Fig. 7.3.1.-4 Wrong IP address error message

- If an SNTP IP address is filled as 0.0.0.0 or 255.255.255.255 in the Substation and Communication tab, then a warning message is displayed as shown in Fig. 7.3.1.-5.

Fig. 7.3.1.-5 Reserved IP address error message
• If one of the enabled fields (for example the substation name) is not filled in the Substation and Communication tab, an error message is displayed when clicking Generate (see Fig. 7.3.1.-6).

![Image of Substation name error message](image1)

**Fig. 7.3.1.-6 Substation name error message**

• If one of the enabled fields (for example Designation) is not filled in the Primary Switches tab, an error message is displayed when clicking Generate (see Fig. 7.3.1.-7).

![Image of Primary Switches Designation error message](image2)

**Fig. 7.3.1.-7 Primary Switches Designation error message**

• In the General status and control I/Os’ tab, only numbers are allowed to be entered in the LNGGIO Instance Number and DOI Number fields. If entered data is other than a number, an error message is displayed as shown in Fig. 7.3.1.-8.

![Image of Instance Number and DOI Number error message](image3)

**Fig. 7.3.1.-8 Instance Number and DOI Number error message**

• In the General Status and control I/Os tab, the user has to start LNGGIO Prefix with alphabets only, otherwise an error message is displayed as shown in Fig. 7.3.1.-9.

![Image of Prefix error message](image4)

**Fig. 7.3.1.-9 Prefix error message**
Fig. 7.3.1.-9  **GGIO prefix error message**

- If one of the enabled fields (for example DOI Name) is not filled in the General status and control I/Os’ tab, an error message is displayed when clicking **Generate** (see Fig. 7.3.1.-10).

  The Prefix field is not mandatory.

Fig. 7.3.1.-10  **DOI name error message**

- In the General status and control tab it is not allowed to enter duplicate entries for DOIs of types other than SPCSO and ISCSO. If the same entries are entered in LN Prefix, LN Instance number, DOI Type, or DOI Number, an error message containing the rows with duplicate entries is displayed when clicking **Generate** (see Fig. 7.3.1.-11).

Fig. 7.3.1.-11  **Identical information for GGIO error message**

- If SPCSO/ISCSO is selected for a Read FUPLA object in the General Status and Control tab, and the Read FUPLA object does not have any corresponding Write FUPLA object, then an error message is displayed as shown in Fig. 7.3.1.-12.
In the Report Control Blocks tab, only numbers in the Buffer Time and Configuration Revision fields are allowed. If non-numeric data is entered, an error message is displayed as shown in Fig. 7.3.1.-13.

When entering a wrong IP/IP subnet/IP gateway address in the Report Control Blocks tab, an error message is displayed as shown in Fig. 7.3.1.-14.

If any of the enabled field in the Report Control Blocks tab (for example Buffer Time) is not filled, an error message is displayed when clicking Generate (see Fig. 7.3.1.-15).
The FCDA entries are restricted based on the DOI entries. If the DOI entries reach a maximum of 250, the addition of FCDAs is stopped. If any FCDAs exist beyond this number, they are collected and added to the next dataset element, StatNmI, and so on. A new dataset like StatNmIC is added if B overflows. The maximum number of possible datasets for protection events is 6. In case there is a dataset overflow, error messages as shown in Fig. 7.3.1.16 are displayed.

![Dataset overflow notification](image1)

Fig. 7.3.1.16 Dataset overflow notification

When generating the SCL (ICD/CID) file, if an error occurs due to invalid data while adding SLD information, an error message shown in Fig. 7.3.1.17 is displayed.

![SLD addition error message](image2)

Fig. 7.3.1.17 SLD addition error message

In the General Status and Control I/Os UI page, if the user changes the DS allocation but does not change the Configuration Revision of RCB rcb_A corresponding to the StatUrg dataset, the SCL Tool displays a message prompting to change the Configuration Revision when the user attempts to generate the SCL file. If the user selects Yes, he is directly taken to the desired field in the RCB section of the GUI, and if the user selects No, the SCL Tool proceeds with the SCL Generation.

![Configuration revision change notification](image3)

Fig. 7.3.1.18 Configuration revision change notification

In RCB client, if the user enters the Client IED Name as Dummy, an error message shown in Fig. 7.3.1.19 is displayed.
7.3.2. SCL Import

- If a user tries to add an LN in LN Wizard and does not start the Prefix with an alphabet, an error message shown in Fig. 7.3.2.-1 is displayed.

- When an addition of a DOI in the DataSet Editor results in an overflow, an error message as shown in Fig. 7.3.2.-2 is displayed.

- If any property of an IED node of an ICD file is changed in the property grid, an error message as shown in Fig. 7.3.2.-3 is displayed.
If the IP addresses are changed to either 0.0.0.0 or 255.255.255.255 in the property grid, a warning message as shown in Fig. 7.3.2.-4 is displayed.

![IP address warning](image1.png)

**Fig. 7.3.2.-4 IP address warning**

If in property bag the user enters another IED Name for the RCB client than in the available list, an error message shown in Fig. 7.3.2.-5 is displayed.

![Client IED name error message](image2.png)

**Fig. 7.3.2.-5 Client IED name error message**

### 7.3.3. FTP download or upload

If the FTP connection is not established in the FTP download or upload section, a message as shown in Fig. 7.3.3.-1 is displayed.

![FTP connection not established](image3.png)

**Fig. 7.3.3.-1 FTP connection not established**
## Terminology

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration Tool</td>
<td>Software program to configure the REF 542plus. This program runs on a PC.</td>
</tr>
<tr>
<td>Data Set</td>
<td>The data set is the content basis for reporting and logging. The data set contains references to the data and data attribute values.</td>
</tr>
<tr>
<td>Ethernet</td>
<td>Physical communication network to transfer Internet data of the REF 542plus to the PC and back.</td>
</tr>
<tr>
<td>Firmware</td>
<td>The base software programs stored inside the REF 542plus. Among them, there are the FUPLA file interpreter and the protection functions programs.</td>
</tr>
<tr>
<td>Report Control Block</td>
<td>The report control block controls the reporting process for event data as they occur. The reporting process continues as long as the communication is available.</td>
</tr>
<tr>
<td>sAddr</td>
<td>Short Address Information The sAddr attribute allows the allocation of a short address to DO attributes. Short addresses can be used within the communication to be more efficient either in the communication, or in the handling of messages at client or server. Furthermore, they can be used as IED internal identification for the attribute.</td>
</tr>
<tr>
<td>SPA</td>
<td>Data communication protocol developed by ABB</td>
</tr>
<tr>
<td>Substation Configuration descrip-</td>
<td>Also known as SCL. XML-based description language for configurations of electrical substation IEDs. Defined in the IEC 61850 standard.</td>
</tr>
<tr>
<td>tion Language</td>
<td></td>
</tr>
</tbody>
</table>
## Abbreviations

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CB</td>
<td>Circuit-breaker</td>
</tr>
<tr>
<td>CDC</td>
<td>Common data class</td>
</tr>
<tr>
<td>CID</td>
<td>Configured IED description</td>
</tr>
<tr>
<td>DO</td>
<td>Data object</td>
</tr>
<tr>
<td>DOI</td>
<td>Data object instance</td>
</tr>
<tr>
<td>DS</td>
<td>Data set</td>
</tr>
<tr>
<td>FTP</td>
<td>File transfer protocol</td>
</tr>
<tr>
<td>FUPLA</td>
<td>Function block programming language; Functional programming language; Function plan; Function chart</td>
</tr>
<tr>
<td>GUI</td>
<td>Graphical user interface</td>
</tr>
<tr>
<td>ICD</td>
<td>IED capability description</td>
</tr>
<tr>
<td>IED</td>
<td>Intelligent electronic device</td>
</tr>
<tr>
<td>IP</td>
<td>Internet protocol</td>
</tr>
<tr>
<td>LD</td>
<td>Logical device</td>
</tr>
<tr>
<td>LN</td>
<td>Logical node</td>
</tr>
<tr>
<td>MMS</td>
<td>Manufacturing message specification</td>
</tr>
<tr>
<td>RAM</td>
<td>Random access memory</td>
</tr>
<tr>
<td>RCB</td>
<td>Report Control Block</td>
</tr>
<tr>
<td>SCADA</td>
<td>Supervision, control and data acquisition</td>
</tr>
<tr>
<td>SCL</td>
<td>Substation configuration description language (defined by IEC 61850)</td>
</tr>
<tr>
<td>SLD</td>
<td>Single-line diagram</td>
</tr>
<tr>
<td>SNTP</td>
<td>Simple Network Time Protocol</td>
</tr>
<tr>
<td>SPA</td>
<td>Data communication protocol developed by ABB</td>
</tr>
<tr>
<td>XML</td>
<td>Extensible markup language</td>
</tr>
</tbody>
</table>